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Diese Zusammenstellung basiert auf:

1. dem deutschen Handbuch MuseScore in der Fassung vom 4.2.2011
2. dem englischen Handbuch MuseScore in der Fassung vom 4.2.2011

3. Eigenen Ergänzungen von E.Populorum vom November 2011

4. Forenbeiträgen

1 Allgemein
1.1 Noten(bereich) auswählen
Funktioniert etwas anders als gewohnt:

1. Klick auf erste Note

2. Shift+Klick auf letzte Note

Mit der Maus ziehen geht nicht, weil man damit das Notenblatt verschiebt.

1.2 Copy & Paste

1. Notenbereich auswählen
2. > Bearbeiten > Kopieren
3. Klick in eine leere Stelle des Taktes, ab wo eingefügt werden soll

4. > Bearbeiten > Einfügen
1.3 Edit-Modus

Viele Elemente der Partitur können im Bearbeitungsmodus verändert werden.

• Doppelklick startet den Bearbeitungsmodus
• Escape beendet den Bearbeitungsmodus

Einige Elemente zeigen im Bearbeitungsmodus Anfasser, die mit der Maus oder mit Tastaturkommandos verschoben werden können.

1.4 Menüs zur Änderung von Eigenschaften

1.4.1 > Bearbeiten > Einstellungen
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1.4.2 > Format > Stilvorgaben bearbeiten
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1.4.3 > Format > Text-Stilvorgaben bearbeiten
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Hier können für jede in der Liste enthaltene Textform die Eigenschaften theoretisch eingestellt werden.

Praktisch bleiben viele Einstellungen völlig ohne Wirkung. Bug in V 1.1???
Es scheint, als könne man mit diesem Menü nachträglich keine Änderungen durchführen, sondern man muss immer mit Doppelklick den Bearbeitungsmodus oder mit Rechtsklick den Eigenschaften-Modus aufrufen und kann dann dort ändern.
Bei Liedtexten kann man anscheinend/scheinbar immer nur einzelne Silben ändern.
Aus dem Forum, verfasst von  werner:

Das Einstellen des Notenzeilenabstands funktioniert nicht sehr intuitiv, da MuseScore versucht, immer die gesamte Seite zu füllen. Kleine Änderungen bewirken so zunächst mal gar nichts. Wird in "Format bearbeiten"->Seite der Parameter "Füllgrad Seite" auf 100% gesetzt, so wird diese Automatik ausgeschaltet und die Notenzeilen bekommen den konfigurierten Abstand. Ein verstellen der Werte für Notenzeilenabstand und Akkoladenabstand (für Piano-Systeme) zeigt dann schnell die Wirkung der Parameter.
Das hilft ein wenig, zumindest verändert sich dann was.

1.5 Werkseinstellungen wiederherstellen (Windows)

Umfangreiche individuelle Einstellungen können gesetzt werden unter:

> Bearbeiten > Einstellungen und/oder

> Format > Stilvorgaben bearbeiten und/oder

> Format > Textvorgaben bearbeiten.

Wenn aus irgend einem Grund die individuellen Einstellungen zu Problemen führen, können die Werkseinstellungen wiederhergestellt werden.

1. MuseScore schließen  > Datei > Beenden wenn offen.
2. Windows-Taste + R öffnet das Fenster Ausführen.

3. Klick auf Durchsuchen, suchen die Programmdatei mscore.exe im Datei-Browser

4. Markieren die Programmdatei , click Öffnen
5. Im Ausführen-Fenster steht nun der Dateipfad, etwa "C:\Programme\MuseScore\bin\mscore.exe"
6. Nach dem rechten Anführungszeichen einfügen eine Leerstelle und -F  

7.Klick OK
Nach einigen Sekunden startet MuseScore mit den Werkseinstellungen (Factory Settings).

2 Oberfläche

2.1 Palette

Sie können die Werkzeugpalette mit dem Menüpunkt Ansicht → Palette anzeigen oder verbergen. Sie können diese Funktion auch mit F9 aufrufen.

Die Werkzeugpalette enthält Symbole, die mittels Drag&Drop auf Elemente der Partitur gezogen werden können.

Ein Doppelklick auf ein Palettenelement hat den selben Effekt, als ob dieses Element auf alle ausgewählten Elemente der Partitur gezogen würde. Damit können z.B. auf einfache Weise mehrere Noten mit einem Tenuto-Zeichen versehen werden.
Beispiel:

1. Noten auswählen

2. Doppelklick auf das Tenuto-Symbol in der Palette Artikulation & Verzierungen
2.2 Rückgängig und Wiederherstellen

MuseScore kann beliebig viele Aktionen rückgängig machen. Die Standardtastaturabkürzungen sind:

• Rückgängig machen Strg+Z
• Wiederherstellen Strg+Umschalt⇑+Z or Strg+Y
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Oder verwenden Sie die Symbolleiste 
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Darstellung vergrößern/verkleinern

Im Menü

> Darstellung > Seiteneinstellungen

erscheint ein Fenster.
Standardeinstellung für Maßstab-Spatium ist 1.764 mm. 

Wird dieser Wert verkleinert, verkleinert sich die Darstellung und es passt mehr auf 1 Blatt. Evt. Schrift vergrößern.

Allerdings sind die Ergebnisse, die nach einer Änderung entstehen, nicht immer nachvollziehbar. Viel probieren nötig.
Gewisse, ebenso nicht immer nachvollziehbare Auswirkungen hat auch > Format > Stilvorgaben bearbeiten > Seite. Allerdings bleiben oft Änderungen scheinbar/anscheinend ohne Wirkung
3 Partitur

3.1 Neue Partitur erzeugen
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Der Menüeintrag > Partitur Neu erzeugt eine neue leere Partitur und offnet einen Assistenten. 

Geben Sie entsprechende Informationen für Titel, Komponisten und je nach Bedarf weitere Felder ein.

Weiter unten können Sie unter zwei Optionen wählen, welche Art Partitur Sie erstellen möchten.

• Neue Partitur aus Vorlage erstellen

• Neue Partitur ohne Vorlage erstellen

Mit der ersten Option können Sie im weiteren Verlauf eine fertige Partiturvorlage wählen, mit der Sie Ihre Partitur erstellen möchten, die zweite Option ermöglicht dagegen die freie Auswahl der gewünschten Instrumente und anderer Einstellungen. 
Vorlagen werden weiter unten im Detail besprochen, wir befassen uns zunächst mit der Option „Neue Partitur erzeugen”.

Um zum nächsten Schritt zu gelangen, klicken Sie bitte auf Weiter.
3.1.1 Stimmen und Instrumente
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Das Instrumentenfenster ist in zwei Hälften unterteilt. Die linke Hälfte zeigt die auswählbaren Stimmen und Instrumente. Die rechte Hälfte ist anfangs leer und enthält nach dem Auswählen die Instrumente der neuen Partitur.

Die Instrumentenliste links ist kategorisiert nach Instrumenten-Familien. Ein Doppelklick auf eine Kategorie zeigt die komplette Liste der zugehörigen Instrumente. Wählen Sie ein Instrument aus und klicken Sie Hinzufügen, danach erscheint dieses Instrument in der rechten Hälfte. Fügen Sie so viele Instrumente hinzu, wie Sie möchten.

Die Reihenfolge der Instrumente in der rechten Hälfte entspricht der in der Partitur. Um diese zu ändern, wählen Sie ein Instrument aus und klicken Sie auf„Nach oben oder Nach unten, um seine Position zu verändern. 

Wenn Sie fertig sind, klicken Sie bitte auf Weiter.

Löschen einer ganzen Stimme:

1. > Einfügen > Stimmen & Instrumente

2. Gewünschtes markieren, dann Entf.
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Tonart (Vorzeichen)

Wenn Sie die neueste Version von MuseScore verwenden, können Sie als nächstes die Vorzeichen für Ihre Partitur wählen. In frühere Versionen existiert dieser Schritt nicht, die Vorzeichnung kann nach Erstellung der Partitur noch geändert werden.
Wähle Sie die gewünschten Tonart aus und klicken Sie auf Weiter.

3.1.2 Taktart, Auftakt und Taktanzahl
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Falls ihre Partitur mit einem Auftakt beginnen soll, wählen die Option Auftakt und stellen Sie dessen Dauer entsprechend ein.

Geben Sie auch die ungefähre Anzahl an benötigten Takten ein, Sie können später beliebig Takte zu ihrer Partitur hinzufügen oder entfernen.

Klicken Sie auf Abschließen um die neue Partitur zu erstellen.

3.2 Anpassungen der Partitur nach dem Erzeugen

Sie können sämtliche Einstellungen, die Sie im Assistenten vorgenommen haben, auch während der Bearbeitung der Partitur verändern.

• Um Takte zu löschen oder hinzuzufügen oder einen Auftakt zu erzeugen siehe Takte bearbeiten.
• Um Texte zu ändern siehe Text bearbeiten. Um einen fehlenden Titel (oder anderen Text) hinzuzufügen, benutzen Sie aus dem Menü Einfügen > Text > Titel (oder eine andere Textart).

• Um Instrumente hinzuzufügen, zu löschen oder deren Reihenfolge zu ändern, benutzen Sie aus dem Menü Einfügen > Stimmen/Instrumente....
3.3 Neue Partitur aus Template erzeugen

Die erste Seite des Assistenten für eine neue Partitur hat eine Option, um eine Partitur aus einer Vorlage zu erzeugen (siehe Titel, Komponist und weitere Informationen oben für Details). Um eine Partitur mit dieser Methode zu erzeugen wählen Sie die Vorlagen-Option und klicken Sie auf Weiter.

Die nächste Seite zeigt eine Auswahl von Vorlagen. Wählen Sie eine aus und klicken Sie auf „Weiter”. Danach fahren Sie wie gewohnt fort.

Die Vorlagen-Dateien sind normale MuseScore-Dateien, die im Vorlagenordner gespeichert sind. Sie können eigene Vorlagen erzeugen, indem Sie MuseScore-Dateien in diesem Ordner speichern. 

Unter Windows liegt der Vorlagenordner üblicherweise unter C:\Programme\MuseScore-xxx\templates. Unter Linux finden Sie den Vorlagenordner für gewöhnlich entweder oder /usr/share/mscore-xxx /templates, oder unter /usr/local/share/mscore-xxx/templates.
4 Eingabe / Änderungen
4.1 Acciaccatura/Appoggiatura (Vorschlagsnote)
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Ein kurzer Vorschlag (Acciaccatura) wird als kleine Note mit durchgestrichenem Hals vor der sogenannten Hauptnote notiert.
 Ein langer Vorschlag (Appoggiatura) ist nicht durchgestrichen. 

Erstellen

Vorschlagsnoten werden durch Ziehen eines Symbols aus der Vorschlagsnoten-Palette auf eine Hauptnote gesetzt. (Bis zur Version 0.9.5 hieß diese Palette nur „Noten”).

Wenn Sie die Dauer einer Vorschlagsnote im Nachhinein ändern möchten, klicken Sie auf die Vorschlagsnote, so dass sie ausgewählt ist, und wählen Sie eine Tondauer aus der Symbolleiste oder per Tastaturkürzel (1 ... 9 (siehe Noteneingabe).
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Akkolade

Hier gleichbedeutend mit "System". Das sind mehrere zusammengehörige Notenzeilen.

4.3 Akzidentien (Versetzungszeichen)
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Versetzungszeichen (oder Akzidentien) werden solche Vorzeichen genannt,

die sich nicht am Anfang eines Abschnitts oder Stückes als Tonartvorzeichnung befinden, sondern im Stück vor einzelnen Noten und deren Tonhöhe beeinflussen, dazu gehören unter anderem beispielsweise das Kreuz, das Be, sowie das Auflösungszeichen. 
Ein Versetzungszeichen gilt für den Ton vor dem es steht für die restliche Dauer des Taktes, es kann aber durch ein anderes Versetzungszeichen wieder aufgehoben werden.

Versetzungszeichen können durch Ziehen eines Versetzungszeichensymbols von der Versetzungszeichenpalette auf eine Note gesetzt oder verändert werden.

Wenn sie nur die Tonhöhe einer Note verändern wollen können sie auch die Note selektieren und dann per Tastatur
• ↑ Erhöht die Note um einen Halbton, Schreibweise mit Kreuzen wird bevorzugt.

• ↓ Erniedrigt die Note um einen Halbton, die Schreibweise mit B's.

• Strg+↑ Erhöht die Note um eine Oktave.

• Strg+↓ Erniedigt die Note um eine Oktave.

Sie können einem bestehenden Versetzungszeichen Klammern hinzufügen um es zu einer Warnakzidenzie zu machen. Ziehen Sie hierzu das Klammersymbol aus der Versetzungszeichenpalette auf die Akzidentie, die Sie einklammern möchten. Um die Klammern wieder zu entfernen, markieren Sie das Versetzungszeichen und drücken Sie Entf.

MuseScore wählt automatisch die Position der Note und evtl. ein Versetzungsrzeichen. Wenn sie damit nicht einverstanden sind oder einfach nur ein Sicherheitsvorzeichen setzen wollen, dann können sie immer noch manuell ein Vorzeichen aus der Vorzeichenpalette auf die Note ziehen und die Automatik damit überstimmen. Wenn anschließend wieder die Tonhöhe verändert wird, geht diese manuelle Wahl natürlich verloren.
Die Menüfunktion > Noten> Versetzungszeichen neu berechnen versucht, die Vorzeichen der gesamten Partitur neu zu berechnen.
4.4 Arpeggio
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Ein A. ist ein gebrochener Akkord: die Noten werden nicht gleichzeitig gespielt sondern kurz hintereinander.

Ein Arpeggio wird meistens als eine gewellte vertikale Linie vor einem
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Akkord notiert, es gibt aber auch andere Formen, ein Arpeggio darzustellen. Arpeggios werden durch Ziehen eines Arpeggiosymbols aus der Arpeggiotabelle auf einen Notenkopf eines Akkords gesetzt.
Länge einer Arpeggiolinie ändern, indem Sie einen Doppelklick darauf machen und die Markierung entsprechend verschieben.

4.5 Atemzeichen
[image: image60.png]


[image: image61.png]



Um ein Atemzeichen zu setzen wird es von der Atemzeichenpalette auf eine Note der Partitur gezogen. Das Atemzeichen wird dann vor die Note gesetzt.

4.6 Balken
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Balken werden automatisch gesetzt. Diese Automatik kann mit manuell gesetzten Hinweisen gesteuert werden. Ziehen sie dazu das passende Symbol von der Balken-Palette auf die Note, deren Balkenverhalten geändert werden soll.

Sie können auch zuerst eine Note auswählen und dann auf das Balkensymbol doppelclicken.

[image: image28.png]


Beginnt einen Balken an dieser Note.

[image: image29.bmp]Ein Balken wird an dieser Note nicht beendet.
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Diese Note soll nicht verbalkt werden.

[image: image31.png]


Beginnt eine neue Balkenebene an dieser Note.
4.7 Bindebogen

Ein Bindebogen ist eine gebogene Linie, die zwei oder mehrere Noten überspannt, und wird üblicherweise verwendet um anzuzeigen, dass die Noten unter dem Bogen gebunden gespielt werden sollen. 

Erstellung
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1. Verlassen Sie den Noteneingabemodus mit ESC und wählen Sie die erste Note aus:
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2. Erstellen Sie einen Bogen mit S:
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3. Umschalt⇑+→ bewegt das Ende des Bogens zur nächsten Note:
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4. Mit X können wählen ob der Bogen über oder unter den Noten erscheinen soll
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5. Esc beendet den Bogen-Bearbeitungsmodus:
Anpassungen

Im Bearbeitungsmodus erscheinen sogenannte „Anfasser”, Sie können sie mit der Maus verschieben. Die beiden äußerem Anfasser bestimmen Start und Endpunkt des Bogens, mit den beiden inneren können Sie die Höhe des Bogens verändern.

Ein Bogen kann mehrere Systeme oder sogar Seiten überspannen. Der Start und Endpunkt eines Bogens sind jeweils an einer Note verankert. Wenn Noten wegen Änderungen im Layout ihre Position in der Partitur ändern, werden Bögen mitbewegt und die Größe angepasst.

Anmerkung: Es ist nicht möglich, den Ankerpunkt eines Bogens mit der Maus zu verändern. Verwenden Sie Umschalt⇑ + ← oder → um die Ankerpunkte für Bogenbeginn und -ende festzulegen.

Gestrichelte Bögen

Gestrichelte Bögen werden oft in Liedern mit mehreren Strophen verwendet um Unterschiede in der Silbenverteilung der einzelnen Strophen anzuzeigen.

Gestrichelte Bögen können außerdem auf Vorschläge eines Herausgebers zurückgehen (um eine unterscheidbare Darstellung zur Originalbogensetzung des Komponisten zu ermöglichen). 
Um einen Bogen gestrichelt darzustellen, machen Sie einen Rechtsklick auf den Bogen und wählen Sie
 > Eigenschaften Bindebogen.... 
Es erscheint ein Dialogfenster, in dem Sie die gewünschte Darstellung wählen können.
4.8 Fingersatz
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Um Fingersatz zu notieren wird ein Symbol der Fingersatzpalette auf einen Notenkopf der Partitur

gezogen. Fingersatz ist normaler Text, der normal editiert werden kann.
4.9 Haltebogen

Haltebögen sind Bögen, die 2 Noten der gleichen Stimme und der gleichen Tonhöhe verbinden, z.B. über Taktgrenzen hinweg.
1. Raus aus Noteneingabemodus, falls nötig mit Esc
2.Note markieren, +
4.10 Klammern
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Einfügen

Ziehen Sie ein Klammersymbol aus der Klammern-Palette in den freien Bereich des ersten Taktes in einem System.

Ändern

Ziehen Sie ein Klammersymbol aus der Klammern-Palette auf eine bestehende Klammer in Ihrer Partitur.

Horizontale Position

Ab der Version 0.9.4 können Sie die horizontale Position einer Klammer anpassen. Machen Sie einen Doppelklick auf eine Klammer und Drücken Sie Umschalt⇑+← oder Umschalt⇑+→ um sie nach links oder rechts zu bewegen.

Bearbeiten

Mit einem Doppelklick auf eine Klammer kommen Sie in den Bearbeitungsmodus. So können Sie die Höhe der Klammer verändern um die Klammer auf mehrere Notenzeilen zu erweitern. Ziehen sie ein Klammersymbol von der Klammerpalette auf eine leere Stelle des ersten Taktes eines Systems.
Entfernen

Wählen Sie die Klammer aus und drücken Sie Entf.
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Linienobjekte eingeben
1. Zuerst die Note markieren, wo das Linienobjekt beginnen soll.

2. Das Linienobjekt aus der Palette auf diese Note ziehen.

Genaue Beschreibung siehe "Gabeln erfassen"

Gabeln erfassen
Um eine Gabel zu erzeugen muß zunächst eine Note ausgewählt werden, um den Startpunkt zu markieren.

• 
H 

 erzeugt eine Crescendogabel

• 


     Umsch+H

erzeugt eine Diminuendogabel (Decrescendogabel)

H erzeugt eine Crescendo Gabel:
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Doppelclick schaltet in den Edit Mode:
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Umsch+rechts verschiebt den End-Anker:
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rechts verschiebt den Endpunkt:
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Ändern eines Linienobjektes
Wenn Sie mit Hilfe der Maus die Länge eines Linienelements ändern, bleibt der Anker des Elements bestehen - das heißt, die Linie orientiert sich an derselben Note. Wir empfehlen Ihnen die folgende Methode um Start- und Endpunkte einer Linie zu verschieben:

1. Vergewissern Sie sich, dass sie sich nicht im Noteneingabe-Modus befinden (Sie können den Modus mit N wechseln. Mit Esc verlassen Sie den Noteneingabemodus).

2. Machen Sie einen Doppelklick auf das Linienelement, dessen Länge oder Ankerpunkte Sie ändern möchten. Es erscheinen eine Start- und eine Endmarkierung der Linie.

3. Wählen Sie mit der Maus per einfachem Klick eine der beiden Markierungen aus

4. Bewegen Sie die Markierung mit den Pfeiltasten wie folgt

• ⇑Shift+← und

• ⇑Shift+→ um den Ankerpunkt um eine Note (bzw. einen Takt) zu verschieben

5. Um die Markierungen zu verschieben, die Ankerpunkte aber unverändert zu lassen, verwenden Sie nur die Pfeiltasten

• ← und

• → um die Markierungspunkte zu verschieben.

• Benutzen Sie Strg+Pfeiltasten für die Feinjustierung der Position.

4.12 N-tolen (Triolen)

Notation

N-tolen werden verwendet, wenn übergeordnete Notenwerte anders als durch die Taktart vorgegeben in nächstkleinere Notenwerte geteilt werden sollen. Eine Triole in einem geraden Takt beispielsweise teilt den nächstgrößeren Notenwert in 3 statt 2 Teile. Beispiele für N-tolen sind:

Duole, Triole, Quintole.

N-tolen werden als kleine Ziffer unter oder über einer Gruppe von Noten notiert, wahlweise durch eckige Klammern gekennzeichnet.

Erstellen

Wenn Sie eine Triole eingeben möchten, erstellen Sie zunächst eine Note mit der Gesamtdauer der Triole. Wählen Sie diese Note aus und geben Sie dann Strg+3  ein, um sie in eine Triole umzuwandeln. Entsprechend kann mit Strg+5  eine Quintole erstellt werden.
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Wählen Sie zunächst eine Note aus:
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   Strg+3 erstellt eine Triole, indem die Dauer der gewählten Note in 

drei Teile geteilt wird die weiter bearbeitet werden kann.

Noteneingabemodus

Im Noteneingabemodus funktioniert die Eingabe von Triolen etwas anders.

Ab Version 0.9.5 müssen Sie erst die gewünschte Länge, dann die Tonhöhen eingeben.

1. Starten Sie den Noteneingabemodus mit N.
2. Vergewissern Sie sich, dass sich die Eingabemarkierung an der Stelle befindet, wo Sie die Triole eingeben möchten (Sie können die Markierung mit den Pfeiltasten bewegen).

3. Wählen Sie Viertelnoten als Tondauer aus. Klicken Sie hierzu auf die Viertelnote in der Symbolleiste, oder drücken Sie 5
4. Erstellen Sie eine Triole. Klicken Sie hierzu im Menü auf > Noten > N-tolen > Triolen, oder drücken Sie Ctrl+3 .

5. Beachten Sie, dass automatisch Achtelnoten zur Eingabe ausgewählt wurden. Geben Sie nun Noten ein.

Eigenschaften
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Um das Aussehen einer N-tole zu Ändern klicken Sie bitte mit der rechten Maustaste darauf und wählen Sie
> Eigenschaften N-tole....

Im Auswahlfeld Nummer können Sie wählen, ob die N-tole Sie eine Zahl, ein Verhältnis, oder keine Bezeichnung tragen soll.

Die Auswahl Klammer, gibt Ihnen die Möglichkeit das Anzeigen einer Klammer mit „Klammer” oder „keine” selbst einzustellen. Wenn Sie „automatisch” wählen, wird bei N-tupeln, die Noten ohne Balken enthalten,

eine Klammer angezeigt, sonst nicht.
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4.13 Noteneingabe

Noten werden im Noteneingabemodus eingegeben. Bevor Sie in den Eingabemodus wechseln, wählen Sie bitte eine Position in der Partitur aus, ab der die Noteneingabe erfolgen soll, das kann eine beliebige Note oder Pause sein. Beachten Sie bitte, dass vorhandene Noten und Pausen durch Ihre Eingabe ersetzt werden. Wenn Sie eine Passage einfügen möchten, erstellen Sie erst die benötigte Anzahl leerer Takte an der gewünschten Position in Ihrer Partitur, bevor Sie Noten einfügen.

• N Noteneingabemodus starten.

• Escape Noteneingabemodus beenden.

Nachdem Sie in den Noteneingabemodus gewechselt haben, sollten Sie entweder aus der Symbolleiste oder mit der Tastatur eine Dauer auswählen, mit der Sie Noten oder Pausen eingeben möchten.

• 1: 64tel-Note

• 2: 32tel-Note

• 3: 16tel-Note

• 4: Achtelnote

• 5: Viertelnote

• 6: Halbe Note

• 7: Ganze Note

• 8: Doppelte Ganze Note

• 9: Longa

• .: Punktierung zur markierten Note hinzufügen

Die Eingabe von Noten erfolgt über ihren Namen mit den Tasten C D E F G A B (für H) und C
Mit der 0 (Null) erzeugen Sie eine Pause: C D 0 E. Sie werden merken, dass die Dauer, die sie ausgewählt haben, sowohl für Noten, als auch für Pausen gilt.

Bitte beachten Sie, dass in älteren Versionen von MuseScore Pausen mit der Leertaste eingegeben wurden. In neueren Versionen starten Sie mit der Leertaste die Wiedergabe der Partitur.

Während der Eingabe rückt MuseScore automatisch in Ihrer Partitur vor.

Wenn Sie das nicht möchten, sondern eine weitere Note zu ihrer letzten Eingabe hinzufügen wollen, so dass ein Akkord entsteht, drücken und halten Sie die Umschalt⇑-Taste und geben dann den Notennamen ein, den Sie hinzufügen möchten, zum Beispiel: C D Umschalt⇑+F Umschalt⇑+A E F

Wenn Sie eine punktierte Note eingeben möchten, drücken Sie .. Beispiel: 5 .
C 4 D E F G A
Sie können den zuletzt eingegebenen Ton um jeweils eine Oktave

verschieben:

• Strg+↑: Note um eine Oktave nach oben versetzen.

• Strg+↓: Note um eine Oktave nach unten versetzen.

Weitere Tastaturbefehle:

• x: Richtung des Notenhalses umdrehen.

• Umschalt⇑+x: Notenkopf an anderen Seite des Halses befestigen.

Einzelne Noten in einem Akkord verschieben

Doppelklick auf die zu verschiebende Note (=Edit-Modus), dann mit ←und → die Note verschieben.
MIDI-Keyboard

Ab Version 0.9.6 können Sie Tonhöhen auch mit einem MIDI-Keyboard eingeben. Bis zur Version 0.9.3 wird die MIDI-Eingabe nur auf Linux-Betriebssystemen unterstützt.

1. Schließen sie Ihr MIDI-Keyboard an Ihren Computer an und vergewissern Sie sich, dass es angeschalten ist

2. Starten Sie MuseScore

3. Erstellen Sie eine neue Partitur

4. Klicken Sie auf die Pause im ersten Takt um dort mit der Noteneingabe zu beginnen

5. drücken Sie N um in den Noteneingabemodus zu wechseln

6. Wählen Sie eine Tondauer aus, z.B. 5 für Viertelnoten (siehe oben)

7. Drücken Sie einen Taste auf ihrem MIDI-Keyboard, der entsprechende Ton wird in Ihre Partitur eingefügt

Beachten Sie bitte: mit dem MIDI-Keyboard können Sie jeweils einen einzeln Ton oder einen Akkord eingeben. Die oben beschrieben Art der Noteneingabe mit einem MIDI-Keyboard - sie wird auch manchmal "Step-Time" genannt - ist schnell und präzise. Es gibt Notationsprogramme die einen "Real-Time"- oder Echtzeitmodus anbieten, in dem Sie eine Passage in Echtzeit einspielen können, die von der Notationssoftware aufgeschrieben wird. Diese Art der Eingabe ist oft sehr ungenau und die Resultate unbefriedigend, selbst wenn ein erfahrener Musiker mit sehr teurer Software einspielt. Besonders auf PC-Rechnerarchitekturen treten außerdem hardwarebedintg Probleme mit zu großen Latenzzeiten auf.
Latenz ist die Laufzeit eines Signals vom Tastendruck auf dem MIDI-Keyboard bis zur Software - die eine genaue Umsetzung nahezu unmöglich machen. MuseScore bietet daher nur die beiden oben genannten,

zuverlässigen Eingabemodi an.

Wenn Sie mehrere MIDI-Geräte an ihren Computer angeschlossen haben, kann es sein, dass Sie MuseScore mitteilen müssen, welches davon ihr MIDI-Eingabegerät ist. Ab Version 0.9.6 können Sie rufen Sie den

Menüpunkt >Bearbeiten > Einstellungen. auf.

Im Dialogfenster, das sich öffnet, Klicken Sie den Reiter I/O an und wählen Sie unter „PortMidi Eingang auswählen” Ihr Eingabegerät aus.

Einfärbung von Noten außerhalb des darstellbaren Tonumfangs

Ab der Version 0.9.5 färbt MuseScore Noten, die sich außerhalb des für einen Spieler darstellbaren Tonumfangs eines Instruments befinden, rot oder gelb ein. Hierbei wird gelb verwendet, wenn sich eine Note außerhalb des für einen Laien bequem spiel- oder singbaren Tonumfang befindet, Töne die entweder gar nicht spielbar sind, oder außerhalb des für Profis realistisch umsetzbaren Tonumfangs befinden, werden rot dargestellt. Die Einfärbung ist rein informeller Natur und in Ausdrucken nicht sichtbar. Wenn Sie die Einfärbung von Noten deaktivieren möchten (dies ist ab Version 0.9.6 möglich), wählen sie im Menü >Bearbeiten > Einstellungen, wählen Sie dort den Reiter Noteneingabe und entfernen Sie die Markierung für „Noten außerhalb des darstellbaren Tonumfangs einfärben”.

4.14 Pausen

Aus der Symbolleiste in den Takt ziehen.

4.14.1 Ganztaktpausen 
entstehen durch markieren eines ganzen Absatzes und drücken Entf. Die darin enthaltenen Symbole werden durch eine[image: image43.png]


 Ganztaktpause ersezt.

4.14.2 Mehrtaktpausen
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1. > Format > Stilvorgaben bearbeiten
2. Klick auf Partitur






3. Markieren Mehrtaktpausen erstellen
4.15 Schlüssel
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Das Ziehen eines Schlüssels von der Schlüsselpalette auf einen Takt oder einen Schlüssel der Partitur erzeugt oder verändert Schlüssel.
Verändern

Ziehen sie einen Schlüssel von der Palette auf einen Schlüssel der Partitur. Statt von einer Palette kann mit Umsch+linkeMaustaste+Ziehen;. auch ein Schlüssel der Partitur wie von einer Palette gezogen werden.
Einfügen

Ziehen sie einen Schlüssel von einer Palette auf einen leeren Teil eines Taktes. Dies erstellt einen Schlüssel am Anfang des Taktes. Schlüssel, die nicht am Zeilenanfang stehen werden kleiner dargestellt.

Löschen

Selektieren sie einen Schlüssel und drücken dann Del. 
Achtung: Das verändern/einfügen von Schlüsseln verändert nicht die Tonhöhe irgendeiner Note. Statt dessen werden die Noten verschoben.
4.16 Stimmen
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Stimmen werden benötigt, wenn mehrere Noten gleichzeitig in einer Notenzeile mit unterschiedlichen Rhythmen dargestellt werden sollen, dies gilt für alle Töne die gleichzeitig erklingen, aber unterschiedliche Längen haben ebenso wie Pausen die über oder unter anderen gleichzeitig erklingenden Noten notiert werden sollen Bis zu vier Stimmen können in unabhängigen Rhythmen in einer Zeile notiert werden.

Ebenso, Wenn Sie in einem Akkord innerhalb einer Notenzeile Noten mit Hälsen in unterschiedlicher Richtung benötigen
Vorgehensweise
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1. Beginnen Sie mit der Eingabe der obersten Stimme (das sind alle Noten, deren Hälse später nach oben zeigen sollen)
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2. Bei der Eingabe können die Notenhälse noch nach unten zeigen, ab der Version 0.9.4 ändert MuseScore dies automatisch, sobald eine zweite Stimme dazukommt

3. Version 0.9.3: Wenn Sie Version 0.9.3 oder eine frühere verwenden, müssen Sie nach unten zeigende Notenhälse von Hand anpassen. Wählen Sie dazu eine Note aus und klicken Sie "Richtung umdrehen" [image: image44.png]


in der Symbolleiste, oder drücken Sie die Taste X auf ihrer Tastatur.

4. Wenn Sie Noten anstelle der Maus mithilfe der Tastatur oder eines MIDI-Keyboards eingeben, bewegen Sie die Eingabemarke mit dem Linkspfeil auf ihrer Tastatur, um zum Anfang der Notenzeile zurückzukehren.

5. Wählen Sie per Klick auf "2" [image: image45.png]


in der Symbolleiste (oder Strg+I Strg+2 auf der Tastatur) den Eingabemodus für die zweite Stimme

6. Geben Sie die Noten für die untere Stimme ein

7. Version 0.9.3: Auch hier müssen Benutzer der Version 0.9.3 oder früher die Richtung der Notenhälse bei bedarf von Hand anpassen.
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8. Nachdem Sie alle Noten eingegeben haben, sollte ihre Notenzeile wie folgt aussehen:


Achtung, falls nach Neuinstallation Stimmen nicht funktionieren: --> Computer neu starten.
4.17 Taktangaben

Taktangaben finden Sie in der Palette. Sie können eine Taktangabe auf Ihre Partitur ziehen und an der [image: image75.png]Hj
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gewünschte Stelle ablegen (siehe Palette für eine Beschreibung der 
Werkzeugpalette in MuseScore).

Wenn Sie eine Taktangabe in der Palette nicht finden können, öffnen Sie das Menü
 > Einfügen > Taktarten... um Ihre eigene Taktangabe zu erstellen. Sie können die obere und untere Zahlenangabe auf der rechten Seite wählen.
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In den meisten Fällen werden Sie nur die erste der oberen Zahl ändern müssen. Die weiteren Angaben werden für zusammengesetzte Takte benötigt, bei diesen werden mehrere obere Zahlen mit einem Pluszeichen verbunden.
Auftakte

Es gibt Situationen bei denen die tatsächliche Dauer eines Taktes nicht der Taktangabe entspricht. Ein häufiges Beispiel dafür ist ein Auftakt. Wie Sie die effektive Dauer eines Taktes ändern (hierbei wird keine Taktwechsel angezeigt), Sie unter Takte bearbeiten im Abschnitt Eigenschaften nachlesen.
4.18 Takte

4.18.1 Takte anhängen

Um einen Takt an das Ende der Partitur anzuhängen, drücken Sie bitte Strg+B, oder rufen Sie im Menü
 > Einfügen > Takte> Takt anhängen  auf. Um mehrere Takte anzuhängen, drücken Sie bitte Strg+Umschalt⇑+B, oder wählen Sie im Menü > Einfügen > Takte > Takte anhängen....
4.18.2 Takte einfügen

Wählen Sie bitte zuerst einen Takt aus und drücken Sie dann Einfg, oder wählen Sie im Menü 
> Einfügen > Takte > Takt einfügen, um vor dem ausgewählten Takt einen neuen Takt einzufügen. Um mehrere Takte einzufügen, drücken Sie Strg+Einfg, oder rufen Sie im Menü 
> Einfügen > Takte > Takte einfugen... auf.
4.18.3 Takte löschen

Wählen Sie zuerst einen oder mehrere Takte aus und drücken Sie dann Strg+Entf.
4.18.4 Eigenschaften

Um die Eigenschaften eines Taktes zu bearbeiten, rufen Sie mit einem Rechtsklick in einen freien Bereich eines Taktes das Kontextmenü auf und wählen Sie > Eigenschaften Takt....

Notenzeilen

Mit der Option „sichtbar” können Sie einzelne Notenzeilen des ausgewählten [image: image77.png]I
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Taktes verstecken oder sichtbar machen. Die Option „halslos” macht alle Notenhälse für den ausgewählten Bereich unsichtbar. Für Noten, die normalerweise einen Hals haben, wird nur der Notenkopf angezeigt.

Dauer

Die nominelle Dauer ist die Dauer, die durch die Taktangabe in Ihrer Partitur vorgegeben ist. Sie können die effektive Dauer eines Taktes beliebig ändern.

Normalerweise sind nominelle und effektive Dauer eines Taktes identisch.

Auftakte jedoch zum Beispiel haben eine kürzere effektive als nominelle Dauer.

In der untenstehenden Abbildung hat der Auttakt eine nominale Dauer von 4/4 aber eine effektive Dauer von 1/4. Die beiden folgenden Takte haben sowohl eine nominale als auch eine effektive Dauer von 4/4. Der letzte Takt enthält nur eine punktierte Halbe Note und hat eine effektive Dauer von 3/4.
Irregulär

Ein „irregulärer” Takt wird bei der Nummerierung der Takte nicht berücksichtigt. Üblicherweise haben Auftakte die Eigenschaft „irregulär”.

Wenn Sie Version 0.9.4 oder eine frühere verwenden und einen Takt als irregulär kennzeichnen, müssen Sie unter Umständen Ihre Partitur speichern und neu laden, damit die Taktzahlen aktualisiert werden.
Addiere zu Taktnummer

Sie können auch die Option "Addiere zu Taktnummer" verwenden um die Nummerierung der Takte anzupassen. Sie können dazu eine positiv oder negativ Zahl angeben. Bitte beachten Sie, dass eine sich Änderung auf die Nummerierung aller folgenden Takte auswirkt. Der Wert „-1” ergibt das selbe Resultat wie bei einem „irregulären” Takt.
Layout-Dehnung

Hiermit können Sie den horizontalen Freiraum zwischen den Noten vergrößern oder verkleinern.
Wiederholungszähler

Ist der Takt das Ende einer Wiederholung, kann hier die Anzahl der Durchgänge angegeben werden, die durchlaufen werden sollen.
Mehrtaktpause aufbrechen

Diese Eigenschaft trennt eine Mehrtaktpause am Anfang des gewählten Taktes auf. Sie sollten diese Option auswählen bevor Sie unter > Format > Format-Stilvorgaben bearbeiten... die Option „Mehrtaktpausen erstellen” aktivieren.

Ab Version 0.9.6 werden Mehrtaktpausen automatisch an wichtigen Punkten unterbrochen, wie zum Beispiel an Probenmarkierungen, Taktwechseln, oder Doppelstrichen.
Taktzahlen

MuseScore zeigt automatisch Taktzahlen am Anfang eines Systems an, aber es sind mehrere Einstellungen möglich. Wählen Sie im Menü > Format > Format-Stilvorgaben bearbeiten.... 
Wählen Sie dort im linken Auswahlfeld Zahlen. In der unteren Hälfte auf der rechten Seite befindet sich der Abschnitt Taktzahlen.

Aktivieren Sie die Option Taktzahlen um die automatische Erstellung von Taktzahlen zu aktivieren.
Wählen Sie erste anzeigen, wenn der erste Takt eine Taktzahl bekommen soll.
Wählen Sie alle Notenzeilen wenn in jeder Notenzeile eine eigene Taktzahl stehen soll, sonst bekommt nur die oberste Zeile eines Systems eine Taktzahl.

Sie können außerdem auswählen ob jedes System eine Taktzahl bekommen soll, dann bekommt jeweils der erste Takt eines Systems eine Taktzahl, oder

Intervall wählen und eine Zahl wählen. Wenn Sie zum Beispiel als Intervall 1 angeben, bekommt jeder Takt eine Taktzahl, wenn Sie 5 als Intervall wählen, wird jeder fünfte Takt nummeriert.

4.19 Taktstriche
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Taktstrichart ändern

Taktstriche werden per Drag&Drop aus der Taktstrich-Palette in die Partitur eingefügt. Ziehen Sie hierzu mit der Maus die gewünschte Taktstrichart auf einen Taktstrich in ihrer Partitur um ihn zu ersetzen.

Um einen Taktstrich unsichtbar zu machen, klicken sie mit der rechten Maustaste darauf und wählen sie Unsichtbar machen.
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Systemübergreifende Taktstriche

[image: image80.png]


Um Taktstriche zu verwenden, die sich über mehrere Notenzeilen erstrecken, machen sie einen Doppelklick auf einen beliebigen Taktstrich um seine Länge zu verändern.

Klicken Sie auf die blaue Markierung und ziehen Sie sie zur darunterliegenden Notenzeile. Sobald Sie den Bearbeitungsmodus verlassen (z.B. per Mausklick auf eine freie Stelle in Ihrer Partitur) werden alle Taktstriche Ihrer Partitur entsprechend angepasst.

4.20 Tempo

Das Tempo kann entweder über das Wiedergabepult in bpm gesteuert werden oder über den Tempo-Text.

Wiedergabepult: siehe dort.

Tempo-Text: 

1. Note markieren, bei der der Text beginnen soll
2. > Einfügen > Text > Tempo
3. OK

Der Tempo-Text kann mit Doppelklick geändert werden. Sie können die F2-Palette verwenden um eine Viertel-Note (oder anderer Wert) dem Text hinzuzufügen: [image: image46.png]Andantes= 75



. Die bpm können geändert werden durch 
Rechtsklick auf den Text > Tempo Eigenschaften. 
4.21 Text 

4.21.1 Allgemein
Doppelklick auf den Text öffnet den Edit-Modus.
• Strg+B 
 Fettschrift ein/aus

• Strg+I 

Kursivschrift ein/aus

• Strg+U
 
Unterstreichen ein/aus

↑

Hochstellen

↓

Tiefstellen

• Pos1 Ende ← → Cursor bewegen
• Backspace löscht Zeichen links vom Cursor

• Entf 
löscht Zeichen rechts vom Cursor

• Enter
 neue Zeile beginnen

• F2
 Zeigt die Textsymbolpalette, Die Textpalette kann zur Eingabe von Zeichen und Symbolen

verwendet werden, die nicht auf der Tastatur verfügbar sind.

4.21.2 Symbole und Sonderzeichen
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Sie können Viertelnoten, Brüche, und andere Sonderzeichen als Symbole in Ihren Text einfügen. In der Textpalette klicken Sie auf das Tastatursymbol um die Textsymbolpalette zu öffnen
4.21.3 Überschriften etc.  ändern
Möglichkeit a) Titel, Komponist, Texter und Untertitel können nachträglich geändert werden durch:
1. Klick auf  Text, er wird farbig markiert.

2. Rechts Klick > Texteigenschaften
Es erscheint das Texteigenschaften-Fenster.
Bei mir hat nicht funktioniert: Text Linksbündig stellen.

Titel auf jeder Seite wiederholen

Geht in V 1.1 nicht. Muss man über einen Rahmen auf jeder Seite als Text eingeben.

Oder: Als "Copyright" eingeben, das kommt am Fuß jeder Seite automatisch.

4.21.4 Typen und Eigenschaften

Titel, Untertitel, Komponist und Texter sind an der jeweiligen Seite verankert.

Der Fingersatz ist am Notenkopf verankert.
Liedtexte und Akkordnamen sind an einer Zeitposition (Note, Pause) verankert
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4.21.5 Liedtexte eingeben

[image: image83.png]


1. Zuerst alle Noten eingeben.

2.Die erste Note auswählen, wo Text beginnen soll.

3. Strg+L ein um in den Editmodus zu gelangen. Nun den Liedtext für die erste Note eingeben
4. Leertaste positioniert auf die nächste Note.

5. Die Eingabe von - positioniert auf die nächste Note und verbindet die letzte Silbe mit der aktuellen mit einem Strich.

6. Umsch+Leertaste positioniert auf die vorherige Note.








     7. Enter springt in eine neue Zeile für die nächste







     Strophe.

Das nachträgliche Einfügen eines Liedtextes VOR einer oder zwischen 2 Textzeilen ist nicht möglich.
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Soll eine Silbe über mehrere Noten gesungen werden, so wird dies mit einem Unterstreichungsstrich angezeigt:

Der Text wird mit soul, _ _ _ To Esc erzeugt.

Liedtext Schriftart, -Größe ändern

> Format > Textstilvorgaben bearbeiten > Liedtext gerade/ungerade Zeilen würde sich anbieten, aber Änderungen hier bewirken gar nichts.

Ich habe nur folgenden komplizierten Weg gefunden:

1. Erste Textsilbe anklicken
2. Jede weitere gewünschte Silbe mit Strg+Klick additiv markieren

oder  Rechtsklick > Auswahl > Alle ähnlichen Elemente markiert gesamten Text
2. Rechts Klick auf beliebige markierte Silbe > Texteigenschaften
3. Hier kann Schriftart und Schriftgrad geändert werden.

4.21.6 Notenzeilentexte eingeben

Notenzeilentexte sind wie Liedtexte an einer Note verankert. Die Notenzeilentexte werden - im Gegensatz zu den Liedtexten - aber nicht in notenabhängige Silben aufgeteilt sondern in einem fort geschrieben.

Note markieren, Strg+T

Notenzeilentexte können mit der Maus beliebig verschoben werden.
4.21.7 Stimmen und Instrumente

Eingabe bei Neuer Partitur Siehe --> Neue Partitur erzeugen.
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Ändern

1. Rechts Klicken in die entsprechende Notenzeile

2. > Eigenschaften Notenzeile, es erscheint Fenster

Hier können weitere Eigenschaften geändert werden.

Schriftart und Größe ist hier nicht änderbar, nur der Text.
4.21.8 Sonderzeichen

Liedtext kann wie normaler Text eingegeben werden mit ein paar Ausnahmen. Wenn Sie ein Leerzeichen, einen Bindestrich oder einen Unterstrich innerhalb einer Silbe eingeben möchten, verwenden Sie die folgenden Tastaturkürzel.

• Strg+Leertaste fügt ein Leerzeichen in den Liedtext ein
• Strg+-  fügt einen Bindestrich (-) in den Liedtext ein

4.21.9 Akkordbezeichnungen

Akkordbezeichnungen können eingegeben werden, indem Sie eine Note auswählen und Strg+K drücken. Damit erstellen Sie eine Akkordbezeichnung über dem ausgewählten Akkord.

• Drücken Sie die Leertaste um zum nächsten Akkord zu springen.

• Umschalt⇑+Leertaste zum vorhergehenden Akkord.

• Strg+ Leertaste Fügt ein Leerzeichen zur Akkordbezeichnung hinzu.

Akkordbezeichnungen können als normaler Text eingegeben werden. Um ein Kreuz einzufügen, verwenden Sie #, für ein b b. Diese Zeichen werden automatisch durch Vorzeichen und Kreuze ersetzt, wenn Sie zum nächsten Akkord springen.
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Jazz-Font

Wenn Sie eine der Handschrift ähnlichere Darstellung bevorzugen, können Sie ab Version 0.9.5 einen Jazz-Font auswählen.
1. Öffnen Sie im Menü > Format > Format-Stilvorgaben bearbeiten...

2. Wählen Sie im Auswahlfeld auf der linken Seite Akkordbezeichnungen
3. Klicken Sie auf der rechten Seite neben dem Eingabefeld („stdchords.xml”) auf das Symbol und öffnen Sie die Datei jazzchords.xml
4.22 Vorzeichen (Tonart)

Tonarten, bzw. die entsprechenden Vorzeichen, können gesetzt oder [image: image87.png]Volta Properties 7~
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verändert werden, indem ein Symbol aus der Tonartenpalette auf einen Takt oder einen bereits bestehenden Satz von Vorzeichen in der Partitur gezogen wird.
F9 zeigt das Palettenfenster.

Verändern

Ziehen Sie hierzu ein Tonartsymbol von der Tonartenpalette auf ein bestehendes Tonartsymbol in Ihrer Partitur.

Zufügen

Ziehen ein Tonartsymbol von der Tonartenpalette auf einen leeren Teil eines Taktes. Dies erzeugt einen Tonartwechsel am Anfang des Taktes.

Entfernen

Wählen Sie das Tonartsymbol in Ihrer Partitur aus, das Sie löschen möchten und drücken Sie dann Entf.
4.23 Tremolo

Mit Tremolo wird eine schnelle Wiederholung von Noten bezeichnet. Es wird durch ein bis drei schräge Balken [image: image88.png]6.
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am Notenhals einer Note oder beim Zwei-Noten-Tremolo zwischen den Noten dargestellt.

Für Ein- und Zwei-Noten-Tremoli gibt es jeweils getrennte Symbole in der Tremolopalette.

Bei einem Zwei-Noten-Tremolo hat jede Note den Wert der gesamten Dauer des Tremolo. Für ein Tremolo mit der Dauer einer halben Note müssen sie zunächst jedoch zwei Viertelnoten eingeben. Nach dem Ziehen des Tremolosymbols auf die erste Note werden die Notenwerte automatisch verdoppelt.

4.24 Wiederholungen

• [image: image89.png]fe—————

—_—

Kiaviersystem: Akkolade aus zwei &
funfinigen Notensystemen im Vioin- und
Bassschiissel





4.24.1 Einfache Wiederholungen

Anfang und Ende einfacher Wiederholungen können durch Setzen enprechender Taktstriche definiert werden.

Im letzen Takt einer Wiederholung kann unter "Eigenschaften" die Anzahl der vorgesehenen Wiederholungen gesetzt werden. Soll eine Wiederholung beim zweiten Mal etwas anders gespielt werden, so können die Varianten mit einer Volta (sic) gekennzeichnet werden.
4.24.2 Sprünge

Sprünge bestehen allgemein aus drei Teilen:

• springe nach Marke
• spiele bis Marke
• weiter ab Marke

Marken sind Namen, die wir einer Taktposition geben. Zwei Sprungmarken (Anfang, Ende) bezeichnen den Anfang und das Ende eines Stückes und müssen nicht speziell vereinbart werden.

Beispiele:

Bei der Sprunganweisung Da Capo springt die Wiedergabe an den Anfang und spielt das gesamte Stück noch einmal (bis zur impliziten Ende Marke).

Bei der Sprunganweisung Da Capo al Fine springt die Wiedergabe an den Anfang um dann bis zur Marke Fine zu spielen.

Dal Segno al Fine (oder D.S. al Fine) springt zur Segno Marke und spielt dann bis zur Marke Fine

Dal Segno al Coda springt zur Segno Marke und spielt dann bis zur ersten Coda Marke. Das Spiel wird dann an der zweiten Codamarke fortgesetzt.
4.24.3 Volta
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Zuerst aus dem Linien-Menü die Balken hereinziehen.

Soll in einer Wiederholung beim zweiten mal das Ende etwas anders gespielt werden, dann verwendet man die normalen Wiederholungszeichen und kennzeichnet die beider Endvarianten mit Klammern:
Die Klammern können auch mehr als einen Takt überspannen. Durch Doppelklick auf eine Klammer kommen wir in den Bearbeitungsmodus und können die Anfasser mit den Kommandos
• Umsch+Rechts um einen Takt nach rechts
• Umsch+Links um einen Takt nach links
verschieben. Durch diese Kommandos wird das "logische" Ende bzw. der Anfang verschoben, die bestimmen, welche Takte die Volta umklammert.
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Andere Kommandos im Bearbeitungsmodus verschieben die Anfasser auch, haben jedoch keine Auswirkungen bei der Wiedergabe der Wiederholungen sondern wirken nur optisch. Wird der Anfang oder das Ende einer Voltaklammer verschoben, dann zeigt eine gestrichelte Linie von der logischen Voltaposition zur aktuellen Position.
Eigenschaften :

Wiederholungsliste
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In der Wiederholungsliste wird angegeben, in welcher Wiederholung die Volta gespielt werden soll. Gibt es mehrere Wiederholungen und soll die Volta in mehreren Wiederholungen gespielt werden, dann müssen sie einzeln per Komma getrennt aufgeführt werden.
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Text

Über den Eigenschaften Dialog läßt sich ein beliebiger Text für die Volta einstellen. Der Text sollte natürlich mit der Liste der Wiederholungen korrespondieren.

5 Partitur speichern
Eine Partitur kann über das Pulldownmenü >Partitur Speichern als... in verschiedene Formate

exportiert werden:

	.mscz
	Komprimiertes MuseScore Format
MSCZ ist das Standard-MuseScore-Dateiformat und wird für die meisten Anwendungen empfohlen. Eine Partitur wird mit diesem Format möglichst platzsparend gespeichert, enthält aber alle Informationen der Partitur. Dieses Format ist die ZIP-komprimierte Version des .mscx-Dateiformats.

	.mscx
	MuseScore Format
MSCX ist die unkomprimierte Version des MuseScore-Dateiformats und steht ab Version 0.9.5 oder später zur Verfügung. Eine Partitur in diesem Format enthält ebenfalls alle Informationen, kann aber in einem Text-Editor bearbeitet werden. 
Ältere Versionen von MuseScore verwenden das MSC-Dateiformat. Die MSC-Dateiendung kann jedoch zu Konflikten unter Microsoft Windows führen und wird von manchen E-Mail-Providern gesperrt. Das neue MSCX-Format ersetzt das ältere MSC-Format um diese Probleme zu umgehen.

	.xml
	MusicXML
MusicXML ist ein allgemeines Standardformat zum Austausch von Musik und wird von den gängigen Notensatzprogrammen unterstützt, wie unter anderem Sibelius, Finale und viele weitere mehr. Es ist das empfohlene Format um Partituren zwischen verschiedenen Notensatzprogrammen auszutauschen.

	.mxl
	Komprimiertes MusicXML
Komprimiertes MusicXML erzeugt kleinere Dateien als das normale MusicXML-Format. Komprimiertes MusicXML ist ein neuerer Standard und nicht so weit verbreitet, wie die unkomnprimierte Version.

	.mid
	MIDI-Format
„Musical Instrument Digital Interface” (MIDI) ist ein Format das weit verbreitet ist unter Squenzern und Notationsprogrammen. MIDI-Dateien wurden jedoch vorrangig für die Audio-Wiedergabe und nicht für Partitur-Layout entwickelt, daher enthalten Sie keine Informationen über die Dinge wie Formatierung, Vorzeichenwahl, Stimmverteilung, Verzierungen, Artikulationen, Wiederholungen oder Tonartvorzeichnungen.
Wenn Sie Partituren zwischen verschiedenen Notationsprogrammen austauschen wollen, verwenden Sie lieber MusicXML. 
Wenn der Schwerpunkt bei der Audio-Wiedergabe liegt, ist das MIDI-Format geeignet.

	.pdf
	Das „Portable Document Format” (PDF) ist ideal um Partituren weiterzugeben, die von anderen nicht bearbeitet werden müssen. Die meisten Computer haben eine Software zur Anzeige von PDF-Dateien, es muss also keine Zusätzliche Software installiert werden, um Ihre Partituren anzeigen zu können.

	.ps
	PostScript (PS) ist eine Seitenbeschreibungssprache die im Druckbereich verbreitet ist.

	.png
	Das „Portable Network Graphics” (PNG) ist ein Bildformat das auf allen verbreiteten Betriebssystemen unterstützt wird und oft in Bildbearbeitungssoftware sowie im Internet verwendet wird. Ab der Version 0.9.3 exportiert MuseScore eine PNG-Datei pro Partiturseite.

MuseScore exportiert als Bilder, was als Druckergebnis sichtbar wäre.

Wenn Sie Bilder erzeugen möchten, die Elemente anzeigen, die nur auf dem Bildschirm sichtbar sind, wie zum Beispiel Rahmen, unsichtbare Noten und die Einfärbung für Noten außerhalb des Tonumfangs, wählen Sie im Menü > Bearbeiten > Einstellungen...
rufen Sie den Export-Reiter auf und wählen Sie die Bildschirmfoto Funktion Option aus.

	.svg
	Scalable Vector Graphics (SVG) kann in den meisten Web-Browsern geöffnet werden (außer dem Internet Explorer) und in Software zur Bearbeitung von Vektorgrafiken. Die meisten SVG-Programme unterstützen jedoch keine Eingebetteten Fonts, daher müssen die passenden MuseScore-Fonts installiert sein um diese Dateien korrekt anzuzeigen.

	.ly
	LilyPond

Das LilyPond-Format kann mit dem Notationsprogramm Lilypond geöffnet werden. Der LilyPond-Export funktioniert noch nicht vollständig und ist in aktuellen Versionen von MuseScore noch experimentell.

	.wav
	WAV Audio

WAV (Waveform Audio Format) ist ein unkomprimiertes Audio-Format das von Microsoft und IBM entwickelt wurde, aber von einer großen Vielfalt von Software für Windows, Mac OS und Linux unterstützt wird.

Es ist ideal geeignet um Audio-CDs herzustellen, da beim speichern in diesem Format kein Qualitätsverlust auftritt. Die Größe der Dateien macht es jedoch schwierig dieses Format zum Austausch über E-Mail oder im Internet zu verwenden. Diese Export-Option ist erst ab MuseScore-Version 0.9.5 oder neuer verfügbar.

	.flac
	FLAC Audio

Free Lossless Audio Codec (FLAC) ist ein komprimiertes Audio-Format.

FLAC-Dateien haben ungefähr die Hälfte der Größe von unkomprimierten Audio-Dateien, das komprimieren ist jedoch verlustfrei, die Originalqualität bleibt erhalten. Windows und Mac OS haben keine eingebaute Unterstützung für FLAC, aber Software wie zum Beispiel der VLC media player kann FLAC-Dateien auf jedem Betriebssystem abspielen. Dieses Format steht ab Version 0.9.5 oder später zur Verfügung.

	.ogg
	Ogg Vorbis

Ogg Vorbis wurde als patentfreier Ersatz für das beliebte MP3-Format entwickelt. Wie auch MP3-Dateien sind Ogg-Vorbis-Dateien vergleichsweise klein (oftmals ein Zehntel der Größe unkomprimierter Dateien), aber ein gewissen Qualitätsverlust tritt dabei auf. 
Windows und Mac OS haben keine eingebaute Unterstützung für Ogg-Vorbis. Der VLC media player und Firefox 3.5 oder neuer können Ogg files auf allen Betriebssystemen wiedergeben. Dieses Format steht ab Version 0.9.5 oder später zur Verfügung.


6 Layout

6.1 Rahmen

Rahmen sind Platzhalter außerhalb der normalen Takte. Sie können leer sein oder Texte oder Bilder enthalten. MuseScore kennt zwei Arten von Rahmen:
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horizontal: Diese Rahmen unterbrechen ein Notensystem. Ihre Breite ist einstellbar,  die Höhe enspricht der aktuellen Systemhöhe. Sie werden z.B. zum Absetzen einer Coda benutzt.
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vertikal: Vertikale Rahmen schaffen Platz zwischen oder vor Notensystemen. Ihre Höhe ist einstellbar und ihre Breite entspricht der Systembreite. Sie werden z.B. für Titel, Subtitel oder Komponist genutzt. Beim Erstellen eines Titels wird automatisch ein vertikaler Rahmen vor dem ersten Takt erzeugt, wenn nicht bereits vorhanden.
Rahmen erzeugen

Zunächst muß der Takt ausgewählt werden, vor dem ein Rahmen eingefügt werden soll. Das Kommando zum Einfügen von Rahmen befindet sich unter > Erzeugen > Takte.
Rahmen löschen

Rahmen markieren und dann Entf drücken.

Rahmen bearbeiten

Ein Doppelklick innerhalb eines Rahmens schaltet in den Bearbeitungsmodus. Es erscheint ein Anfasser, mit dem die Größe des Rahmens (leider nur vertikal!) verstellt werden kann.

Titelrahmen im Bearbeitungsmodus:
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6.2 Umbrüche
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Seiten- oder Zeilenumbrüche (system breaks) können durch Ziehen eines entsprechenden Symbols aus der Umbruchpalette auf eine freie Stelle eines Taktes erzwungen werden. Der gesetzte Umbruch wird nach dem gewählten Takt ausgeführt. Die sichtbaren grünen Umbruchmarker dienen nur als Hinweis und erscheinen nicht im Ausdruck.
Manchmal ist es wünschenswert, aufgetrennte Takte zu haben, also einen Systemumbruch in der Mitte eines Taktes, statt an einem Taktstrich. Wenn Sie zum Beispiel drei Schläge auf einem System und einen Schlag Auftakt im nächsten notieren möchten, müssen Sie zwei Takte mit verkürzter effektiver

Dauer erstellen. Eine entsprechende Darstellung kann mit irregulären Takten erreicht werden, mehr dazu erfahren Sie unter Takte bearbeiten in den Abschnitten „Dauer” und „Irregulär”.
Abstandhalter werden benötigt, um den Abstand zwischen zwei benachbarten Notenzeilen zu vergrößern. Ziehen Sie einen Abstandhalter auf einen Takt über dem Bereich, der vergrößert werden soll. Machen Sie einen Doppelklick auf den Abstandhalter und ziehen Sie die Markierung um die Größe zu verändern.

Wenn Sie die Grundeinstellung für den Notenzeilenabstand verändern möchten, können Sie dies unter 
> Format > Format-Stilvorgaben bearbeiten > Seite. 

Abstandhalter verändern nur die Notenzeile, in der Sie sich befinden.
6.3 Partitur-Auszüge

Es ist möglich, Notenblätter nur für einzelne Stimmen oder Instrumente zu drucken. 
Siehe englisches Handbuch, Seite 53 ff. (Fehlt im deutschen HB).
7 Wiedergabe

MuseScore besitzt einen integrierten Sequenzer sowie einen Synthesizer, um die Partitur wiedergeben zu können.

Durch drücken des Wiedergabe-Buttons wird der Wiedergabemodus gestartet. Im Wiedergabemodus sind die folgenden Befehle verfügbar:

• Leertaste Start/Stop

• ← zum vorherigen Akkord

• → zum nächsten Akkord

• Strg+← zum vorherigen Takt

• Strg+→ zum nächsten Takt

• Pos1 Zurück zum Anfang

• F11 zeigt das Wiedergabepult
Durch Wiederholtes Drücken des Wiedergabe-Buttons verlassen Sie den Wiedergabemodus wieder.

MuseScore nimmt die Wiedergabe an der Stelle wieder auf, an der Sie angehalten haben. Wenn Sie eine Note in Ihrer Partitur auswählen, startet MuseScore beim nächsten Mal die Wiedergabe von dieser dort. In der Symbolleiste finden Sie außerdem einen Button um zum Anfang der Partitur zurückzuspringen.
[image: image97.png]# k]
0 [
@ —

be DCarm
D.c.uCots DS.s1Cot



Wiedergabepult

Im Wiedergabepult (> Ansicht > Wiedergabepult) können weitere Einstellungen vorgenommen werden.

Wiedergabegeschwindigkeit: Regler ziehen

Lautstärke: Regler ziehen

Klangart Straight/Swing/Shuffle auswählen
Die Wiedergabegeschwindigkeit wird in bpm (Beats per minute) angezeigt.
7.1 Instrumente und Klang ändern
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Mischpult
Das Mischpult (Mixer) dient dazu Instrumente, die den einzelnen Notenzeilen zugeordnet sind, zu ändern. Hier kann auch Lautstärke, Links-Rechts-Balance (Pan), Hall (Reverb), Chorus (Klang-Vervielfachung) für jede Notenzeile verändert werden. Um das Mischpult einzublenden, wähle aus dem 

Hauptmenü Anzeige > Mischpult .

Zeigerskalen

Klicke auf die Zeigerskalen und ziehe nach oben, um eine Skala im Uhrzeigersinn zu drehen. Klicke und ziehe nach unten, um gegen den Uhrzeigersinn zu drehen.
7.2.1 Stummschaltung und Solo

Mit dem Stumm-Markierfeld (Mute) kann eine ganze Notenzeile auf stumm geschaltet werden. Umgekehrt dient das Solo-Markierfeld dazu, alle Notenzeilen auf stumm zu schalten, außer derjenigen Notenzeile, die als "Solo" markiert wurde.
7.2.2 Instrumente/Sound

Das Drop-Down-Menü unter "Sound:" listet jedes verfügbare Instrument auf. 
Die verfügbaren Instrumente hängen vom installierten SoundFont ab. Diese Eigenschaft ist erst ab MuseScore Version für Windows 0.9.5 oder später verfügbar.
Klangwechsel im Stück

In MuseScore können einige Instrumente mitten im Stück den Klang ändern. Zum Beispiel können Saiteninstrumente von gestrichen zu gezupft (pizzicato) wechseln oder ein Tremolo aufweisen; Trompeten können zu gedämpfter Spielweise (gestopft) wechseln. Das folgende Beispiel erzeugt einen Teil mit gedämpften Trompetenklang, aber die gleiche Vorgehensweise gilt für pizzicato- oder tremolo-Teile.
1. Markiere die erste Note des gedämpften Teils

2. Wähle aus dem Hauptmenü Erzeugen > Text > Takt gebundener Text
3. Schreibe Mute (oder eine äquivalenten Ausdruck wie Con Sordino). Dieser Text dient nur dem angezeigten Notenblatt und hat keinen Einfluss auf die Tonerzeugung in MuseScore

4. Rechts-Klick auf die eben erzeugte Text-Box Eigenschaften Notenzeilentext...

5. Im erscheinenden Dialogkasten markiere das Kästchen Kanal
6. Im gleichen Dialogfeld markiere das Kästchen Mute
7. Klicke auf OK, um die Eingabe abzuschliessen und zur Partitur zurückzukehren
Jede Note, welche nach einer so bearbeiteten Note eingegeben wird, wird in MuseScore ebenfalls gedämpft wiedergegeben. Um wieder zu einem ungedäpften Klang zurückzukehren, befolge obige Vorgehensweise, aber schreibe Offen in Schritt 3 und wähle Normal in Schritt 6.
7.2.3 SoundFont

Ihre MuseScore-Installation beinhaltet einen SoundFont, das ist eine Datei, die Wiedergabe-Klänge für jedes Instrument enthält. Es gibt SoundFont speziell für die Wiedergabe von klassischer Musik, Jazz oder Pop-Musik, SoundFont können sich erheblich Größenunterschiede aufweisen. 
Neuere MuseScore-Versionen (ab 0.9.6) enthalten einen kleinen Allzweck-SoundFont, Sie finden Ihn in der Datei "TimGM6mb.sf2".

Überblick

Eine SoundFont-Datei kann Klänge für eine beliebige Anzahl von Instumenten enthalten. Es gibt im Internet zahllose frei verfügbare SoundFonts. Wenn Sie einen davon ausprobieren möchten, empfiehlt es sich, einen SoundFont zu verwenden der die 128 Instrumente nach dem General MIDI-Standard (GM) abdeckt.
 Andernfalls werden Ihre Dateien unter Umständen nicht mit den richtigen Instrumenten abgespielt, wenn Sie auf einem anderen Rechner abspielen.

Die Dateigrößen und die Klangqualität von SoundFonts, die Sie im Internet finden, sind sehr unterschiedlich. Als Faustregel können Sie davon ausgehen, dass größere SoundFonts auch eine bessere Qualität mit sich bringen. Es kann allerdings sein, dass eine zu große SoundFont-Datei auf Ihrem System nicht funktioniert. 
Wenn Ihnen MuseScore nach der Installation eines neuen SoundFonts zu langsam vorkommt, oder die Wiedergabe von Partituren nicht reibungsfrei läuft, versuchen Sie es mit einem kleineren SoundFont. Im folgenden sind drei verbreitete SoundFonts unterschiedlicher Größe beschrieben:

• FluidR3_GM.sf2 (141 MB unkomprimiert), download Fluid-soundfont.tar.gz (129 MB)

• MagicSF_ver2.sf2 (67.8 MB unkomprimiert), hierzu Big SoundFonts (englisch)

• TimGM6mb.sf2 (5.7 MB unkomprimiert), download modified TimGM6mb.sf2 (Mit freundlicher Genehmigung von Tim Brechbill)

Komprimierung

SoundFont-Dateien können sehr groß sein und werden deswegen üblicherweise in Komprimierter Form zum Download angeboten, erkennbar unter anderen an den Dateiendungen .zip, .sfArk, oder .tar.gz. Diese Dateien müssen vor ihrer Verwendung erst entpackt werden.

• ZIP ist ein Standard-Komprimierungsformat das auf den meisten Betriebssystemen verfügbar ist.

• sfArk ist ein Format das speziell für die Komprimiertung von SoundFonts entwickelt wurde. Werwenden Sie zum dekomprimieren bitte die sfArk-Software.

• .tar.gz ist ein in der Linux/Unix-Welt verbreitetes Komprimierungsformat. Windows-Benutzer können das freie 7-zip zum entpacken verwenden, das auch die meisten anderen gängigen Komprimierungsformate unterstützt. In diesem Fall beachten Sie bitte, dass ein .tar.gz-Archiv zweimal entpackt werden muss (GZip und TAR).
MuseScore Einstellungen

Nachdem Sie einen SoundFont heruntergeladen und entpackt haben müssen Sie ihn in MuseScore einbinden. Speichern Sie den SoundFont in einem Ordner ihrer Wahl und nehmen sie die folgenden Einstellungen in MuseScore vor:

> Ansicht > Synthesizer. Der eingestellte Pfad zur voreingestellten SoundFont-Datei hängt vom Betriebssystem ab und sieht in etwa wie folgt aus:

• Windows: C:/Programme/MuseScore//sound/TimGM6mb.sf2
• Windows (64-bit): C:/Programme (x86)/MuseScore//sound/TimGM6mb.sf2

Klicken Sie auf das "Öffnen"-Symbol neben dem Eingabefeld für den SoundFont-Pfad und navigieren Sie zu dem Ordner, der Ihre SoundFont-Datei (.sf2) enthält. Wählen Sie Ihre Datei aus und Drücken Sie "Öffnen".
Fehlerdiagnose

Wenn Die Wiedergabe-Werkzeuge-Leiste in Ihrer Symbolleiste grau und deaktiviert oder nicht sichtbar ist, versuchen Sie den folgenden Ansatz um die Audio-Wiedergabe wieder zu reparieren.

Vergewissern Sie sich, dass im Menü Ansicht > Wiedergabe markiert ist. Wenn nicht, klicken Sie ihn an, so das die Auswahlmarkierung erscheint.

Wenn das Problem mit der Wiedergabesymbolleiste weiterhin besteht, versuchen Sie den nächsten Schritt;

Wenn die Wiedergabesymbolleiste nach der Änderung des SoundFonts verschwindet, Öffnen Sie im Dialog unter > Edit > Preferences... den Reiter I/O und Klicken Sie auf OK, ohne weitere Änderungen vorzunehmen. 
Nach einem Neustart von MuseScore sollte die Wiedergabesymbolleiste wieder erscheinen. Es handelt sich hierbei um einen bekannten Fehler in der MuseScore 0.9.3 und in früheren Versionen.

Wenn Sie zum ersten Mal den Soundfont ändern, verwenden Sie bitte zunächst einen der obengenannten.
8 Tipps & Tricks

Hilfreich: http://musescore.org/de/forum

8.1 Abstand von Notensystemen auf mehreren Seiten angleichen

Problem: ein Stück ist über zwei Seiten gesetzt, das Problem ist nun folgendes:
Es sollten die Systeme auf beiden Seiten auf der gleichen Höhe sein, das geht aber weder mit den Abstands-Optionen noch mit dem Spatium.

Lösung: Hänge einen vertikalen Rahmen an und verändere dessen Größe bis es passt.

8.2 Refrainklammer
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Problem: Im Lyric-Teil kommt zwischen den Versen und dem Refrain oft eine geschwungene Klammer (siehe Skizze). Wie geht das?

Lösung:

1. Strg-L Liedtext eingeben

2. Note auswählen 

3. Strg-T Notenzeilentext eingeben ({)

4. Geschweifte Klammer nach unten ziehen

5. Rechtsklick > Eigenschaften / Größe 45,
empfohlen: Schriftart Courier, die hat dünnere Klammern.
8.3 Kopierte Noten in Zweite Stimme einfügen
Problem: ich habe eine vierstimmige Chorpartitur, in der jede Stimme in einer eigenen Notenzeile steht. Nun möchte ich gerne jeweils zwei Stimmen in ein und dieselbe Notenzeile packen, sodass ich am Ende nur noch zwei Notenzeilen (mit je zwei Stimmen) habe. Leider habe ich bei musescore bisher keine entsprechende Möglichkeit gefunden, da man im Noteneingabemodus nicht Kopieren und Einfügen kann und im Bearbeitungsmodus keine Möglichkeit hat, auszuwählen, in welche Stimme der Notenzeile etwas eingefügt werden soll.
Lösung: 
Zielstimme markieren (klick 1. Note, shift klick letzte Note)
Menü/Bearbeiten/Stimmen/Stimme 1-2 austauschen
Quellstimme markieren (klick 1. Note, shift klick letzte Note) und kopieren (Strg C)
Ersten Takt Zielstimme selektieren und einfügen (Strg V)
ggf. nochmal Menü/Bearbeiten/Stimmen/Stimme 1-2 austauschen
fertig
8.4 Liedtexte nicht unter den Noten eingeben

Problem: wie kann ich bitte weitere Liedstrophen eingeben, welche nicht (!) direkt unter den jeweiligen Noten, sondern getrennt unterhalb den Notenzeilen stehen sollen.

Lösung: Einen vertikalen Rahmen einfügen und in ihm weitere Textrahmen, die dann mit den Strophen gefüllt werden können. So können auch mehrere Strophen nebeneinander eingefügt werden.

8.5 Zeilenumbruch verhindern

Problem: Musescore fügt ja automatisch einen Zeilenumbruch ein, bei meinem aktuellen Stück nach 7 Takten. Ich möchte aber gerne erst nach 8 Takten diesen Umbruch haben. Wie bekomme ich das hin?

Lösung: Mit Mausklick 1. Takt markieren, mit Shift -Mausklick 8. Takt markieren, mit "{" zusammmenziehen

9 Offene Fragen

1. Wie kann eine ganze Strophe (Liedtext-Zeile) gelöscht werden?
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